INSTALLATION PREPARATION
PARTS SUPPLIED
PARTS SUPPLIED
Before installing your new Humminbird fishfinder, please ensure the following parts are
included in the box:
•
•
•
•
•

Fishfinder
Transducer with 20’ (6m) of cable and mounting hardware kit
Mounting system and mounting hardware kit
6’ (2m) power cable
Publications kit

It any of these items is missing, call our Customer Support Hotline.
ACCESSORIES
Humminbird offers a wide assortment of accessories that complement and expand the
capability of your new fishfinder. These accessories are designed with the same high
standards and are backed by the same one-year warranty. The Humminbird Accessory
catalog included with your unit contains descriptions of the many accessories available
and ordering information. All Humminbird accessories are available through your fullservice Humminbird dealer or factory direct through our number listed in the Customer
Support section.
INSTALLATION OVERVIEW
Your Humminbird fishfinder consists of two primary components to install: the control
head and the transducer.
The control head contains the sonar transmit and receive circuitry, as well as the user
controls and display. It should be installed in a location that provides access to the
controls and visibility while in use. The control head mounts on a quick disconnect
mounting system that swivels and tilts providing flexibility for viewing from almost
anywhere on the boat.
The transducer converts electrical energy from the transmitter into mechanical pulses or
sound waves. The transducer also receives the reflected sound waves and converts
them back into electrical signals for display on the control head. It should be installed in
contact with the surface of the water in an area that has smooth waterflow- usually on
the transom of the boat. There are several mounting options for the transducer. Review
the following section to determine the method that works for you and your boat.
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Determining How to Mount the Transducer
Your Humminbird fishfinder includes a standard
transducer. This transducer can be mounted on the
transom of the boat or bonded to the inside of a fiberglass
hull boat.
The transom installation, which is the most widely used,
places the transducer on the outside of the boat hull. This
technique produces the least signal loss, and provides a
way to adjust the transducer after installation. The
mounting hardware included is designed to protect both
the boat and the transducer should the boat strike debris in
the water or when trailering.
As an alternative to transom mounting, it is possible on many
fiberglass-hulled boats to glue the transducer on the inside of
the boat hull. Since fiberglass has similar sonar
characteristics as water, the sonar signal can pass through
the boat hull with minimal loss. The hull of the boat must be
single layer construction (not double-hulled) Also, any air
trapped in the lamination of the fiberglass would prevent the
sonar signal from passing through.
Inside the hull installations require no holes be drilled into the
boat and through experimentation, high-speed operation
comparable to transom mounting can be achieved. Two-part
slow cure epoxy (not included) is required to glue the transducer in place.
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ALTERNATE TRANSDUCERS AND MOUNTING METHODS
Your Humminbird fishfinder comes with everything necessary for installation and
operation on most boats. However, there are several situations which may require a
different type of transducer. Inboard boats, wood or metal hulls, and sail boats create
unique transducer mounting needs Alternate transducers and mounting methods are
detailed below.
Portable Mounting
The standard transducer can be adapted for portable
installations with a portable mounting kit available from
Humminbird. This accessory adapts your transducer to a
suction cup mount for temporary installation on the boat hull
or other surface.
Trolling Motor Mounting
The standard transducer can also be adapted to mount on
most trolling motors using a different accessory kit. This
accessory includes a bracket and hose clamp that allows
mounting the transducer to the body of most trolling motors.
Thru-Hull Mounting
Thru-hull transducers install through a hole drilled in the hull
of the boat. Larger boats or boats with inboard motors create
turbulence that make transom mounting ineffective. Also,
hulls that are very thick or are double layered, or made from
materials such as wood or metal, (which do not conduct
sonar signals) make inside the hull mounting inadvisable.
Thru-hull mounting may require the use of a fairing block to level the transducer with the
waterline. Also, since special tools and knowledge may be required to perform this type
of installation, it is best to refer to a qualified marine technician.
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TRANSDUCER EXCHANGE
Other transducers are available as replacements for the standard transducer. You may
exchange your new and unassembled transducer for another type by returning it to the
address listed in Customer Support. Some transducers may have additional cost. Refer
to the Accessory catalog or call Customer Support for information.
BEGINNING INSTALLATION
Now that you have determined the transducer mounting method you can begin
installation of your new Humminbird fishfinder. The installation guide included on the
next few pages provides detailed step by step instructions for installation of the control
head and transducer. For transom mount transducer installations you will need the
mounting template included with your manual.
In addition to the parts included you need the following for installation and operation:
•
•
•
•
•
•
•
•
•

A powered hand drill and various drill bits
Philips and flat-head screwdrivers
A ruler or measuring tape
Pen or pencil
12 volt power source (your boat’s battery)
A 1-amp fuse
A fuse holder (if you are wiring directly to the boat’s battery)
Silicone sealant (for sealing drilled holes)
2-part, slow-cure epoxy (for inside the hull transducer installations)
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Do not begin this transducer installation until you read the Installation
Preparation in the Operation Guide. This chapter contains information critical to
the correct installation of your transducer.
Due to the wide variety of boat hulls, only general instructions are presented in
the installation guide. Each boat hull represents a unique set of requirements that
should be evaluated prior to installation.
TRANSOM INSTALLATION
Step One - Determine Where to Mount the Transducer
Begin the transducer installation by determining where on the
transom to install the transducer. Consider the following to find
the best location:
•

It is very important to locate the transducer in an area which is
relatively free of turbulent water, As a boat moves through the
water, turbulence is generated by the weight of the boat, and
the thrust of the propeller(s). This turbulent water is normally
confined to areas immediately aft of ribs, strakes or rows of
rivets on the bottom of the boat, and in the immediate area of
the propeller(s) (Figure 1). On outboard or inboard/outboard
boats it is best to stay at least 15” (40cm) to the side of the
propeller(s).

•

If possible, viewing the transom of the boat while the boat is
moving will provide the best means of locating turbulence free
water. If maximum high-speed operation is a high priority, this
is the recommended method. If this is not possible, select a
location on the transom where the hull forward of this location
is smooth, flat, and free of protrusions or ribs.

•

The transducer when mounted should point straight down.
The design of the transducer will accommodate a wide range
of deadrises and remain ported straight down (Figure 2).

•

On boats with stepped hulls, it may be possible to mount the transducer on the step.
Never mount the transducer on the transom behind a step, as this area of the
transom will not be in contact with the water at high speed (Figure 3).
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•

If the propeller(s) is (are) forward of the transom, it may be impossible to find an
area clear from turbulence, and a different mounting technique or transducer type
should be considered.

Step Two - Drill the Mounting Holes
1. Remove the mounting template from the front of the Operations Manual.
2. Hold the template on the transom of the boat in the location where the transducer
will be installed (Figure 4). Align the template vertically, ensuring the lower edge of
the transom meets with the bottom corner of the template.
3. Using a pencil or punch, mark the two mounting holes
shown on the template onto the transom. Do not mark or
drill any other holes at this time.
4. Using a 5/32” (4mm) bit drill the two holes to a depth of
approximately 1" (3cm). On fiberglass hulls, it is best to
start with a smaller bit and use progressively larger drill bits
to reduce the chance of chipping or flaking the outer
coating.
Step Three - Assemble the Transducer
1. Attach the Pivot to the transducer body as shown in Figure
5, using the #8 – 3/8” (9mm) long allen headed pivot screw,
the headed pin, the two flat washers, and the two toothed
lock washers.
Note: The toothed lock washers must be positioned
between the transducer and the pivot ears. The flat
washers must be positioned to the outside at the pivot
ears.
2. Using the AIlen wrenches provided, loosely tighten the pivot
screw (Figure 6). Do not completely tighten the assembly at
this time, so the pivot angle can be adjusted later.
3. Insert the pivot/transducer assembly into the mounting
bracket as shown in Figure 7. Do not snap the assembly
closed.
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Step Four - Mount the Transducer to the Transom
1. Apply silicone sealant to the mounting holes drilled into the transom.
2. Align the transducer assembly with the drilled holes in the transom (Figure 8).
3. Use either a flat head screwdriver, a 5/16" (8mm) hex driver, or a 5/16" (8mm)
socket to mount the assembly. Using the two #10 – 1”
(25mm) long slotted hex head screws, mount the transducer
assembly to the transom as shown. Do not fully tighten the
mounting screws in order to vertically adjust the transducer.
Snap the pivot down into place.
Step Five - Adjust the Running Position of the Transducer
The bracket allows height and tilt adjustment, the pivot screws
allow angular adjustment. Initially, adjust the transducer as
described in the following paragraphs. Further adjustment may
be necessary to refine the instillation after high speed testing.
1. First adjust the pivot angle of the transducer body so its
length is parallel with the length of hull of the boat. Then
pivot the transducer down so the rear is about 1/4 inch
(6mm) lower than the front (Figure 9).
2. Fully tighten the two pivot screws using the Allen wrenches.
It may be necessary to retighten the pivot screws after the
initial use as the plastics may still be seating to the lock
washers.
3. Adjust the height of the assembly so the face of the
transducer is 3/16" (4.5mm) beneath the lower edge of the
transom (Figure 10). Mark the position of the mounting
bracket on the transom with a pencil.
4. Force the pivot to the up position to gain access to the
mounting screws. Assure the transducer location has not
changed, then fully tighten the two mounting screws (Figure
11). Snap the pivot back down.
Confirm the pivot angle has not changed.
Note: A third screw location is provided for the
mounting bracket. Drill this hole and install the screw after final testing and
adjustments have been completed.
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Step Six - Route the Cable
There are several ways to route the transducer cable to the to the area where the
control head will be installed. The most common procedure routes the cable through the
transom into the boat.
Inside the boat there is often a channel or conduit used for other
wiring that the cable can be routed along. Do not cut or shorten
the transducer cable and try not to damage the cable insulation.
Route the cable as far as practical from the VHF radio antenna
cables or tachometer cable to reduce the possibility of
interference.
If the cable is too short, extension cables are available to extend
the transducer cable up to a total of 50' (15 m). Call Humminbird
Customer Support for more information.
Follow these steps to route the cable through the transom:
1. Drill a 5/8” (16mm) hole above the water line. Route the
cable through the hole.
2. Fill the hole with silicone sealant.
3. Place the escutcheon plate over the hole and attach with the two #8 x 5/8” (16mm)
screws.
4. Secure the cable by attaching the cable camp to the transom using a #8 x 5/8”
(16mm) screw.
Note: The transducer will pivot up to 90 degrees in the bracket. Allow enough
slack in the cable for this movement. It is best to route the cable to the side of the
transducer so the cable will not be damaged by the transducer during movement.
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Inside the hull installation requires the mount system and control
head be installed and operational. See Installing the Control Head
for instruction on installing the unit.
Inside the hull mounting generally produces good results in single
thickness fiberglass-hulled boats. Humminbird cannot guarantee
depth performance when transmitting and receiving through the
hull of the boat since some signal loss occurs. The amount of loss
depends on hull construction and thickness, and the installation.
This installation requires slow-cure two-part epoxy. Do not use
silicone or any other soft adhesive to install the transducer, as this
material reduces the sensitivity of the unit. Five minute epoxy has
a tendency to cure before all the air bubbles can be purged.
Step One - Determine the Mounting Location
Begin the transducer installation by determining where inside the
hull to install the transducer. Consider the following to find the
best location:
•

Observe the outside of the boat hull to find the areas that are
mostly free from turbulent water. Avoid ribs, strakes, and other
protrusions as these create turbulence (Figure 14).

•

As a general rule, the faster the boat can travel the further aft
and closer to the centerline of the hull the transducer has to be
located to remain in contact with the water at high speeds.

Step Two - Test the Mounting Location
There is no opportunity for adjustment after the transducer glued
in place. Therefore, it is best to perform a trial installation on inside the hull transducers
first, and run the boat at high speeds to determine the best mounting area.
1. At the identified mounting location, lay the transducer body face down with the
pointed end towards the bow.
2. Fill the hull with enough water to submerge the transducer body. Use a sand filled
bag or other heavy object to hold the transducer in position.
The transducer cannot transmit through air. The water purges any air from between
the transducer and the hull and fills any voids in the coarse fiberglass surface.
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3. Power up the Control Head.
4. Run the boat at various speeds and water depths while observing the screen on the
Control Head. If the unit functions well at low speeds but begins to skip or miss the
bottom at higher speeds, the transducer needs to be moved. If depth performance is
required, test the fishfinder in water at the desired depth. Test different locations in
the hull until the optimum performance is achieved.
Step Three - Permanently Mount the Transducer
1. Once the mounting location is determined, mark the position of the transducer.
2. Remove the water from inside the hull and thoroughly dry the
mounting surface. If the surface is excessively rough, it may be
necessary to sand the area to provide a smooth mounting
surface.
Ensure the mounting area is clear and dry.
3. Mix an ample quantity of two-part slow-cure epoxy slowly and
thoroughly. Avoid trapping air bubbles.
4. Coat the face of the transducer and the inside of the hull (Figure
16).
5. Press the transducer into place with a slight twisting motion to
purge any trapped air from underneath, keeping the pointed end
of the transducer body pointed forward (Figure 17).
Note: Proper operation requires the pointed end of the
transducer body to face towards the bow.
6. Weight the transducer so it does not move while the epoxy is curing.
When the epoxy cures, no water is necessary inside the hull. Neither water, spilled
gasoline, or oil will affect the performance of the transducer.
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Step One - Determine Where to Mount
Begin the installation by determining where to mount the control head. Consider the
following to determine best location:
•

The cables for power, transducer and temp/speed accessories (if applicable) should
be installed first and must reach the mounting location. Extension cables are
available.

•

There are two ways to route the cables to the unit: through a
hole in the mounting surface underneath the mounting bracket
or from a hole outside the mounting bracket. Routing the cables
down under the mount provides maximum weather protection;
however this is not always feasible if the area under the
fishfinder is inaccessible. In this case, route the cables through
a hole at another location and cover with the supplied hole
cover.

•

The mounting surface should be adequately supported to
protect the fishfinder from excessive wave shock and vibration,
and provide visibility while in operation.

•

The mounting area should allow sufficient room for the unit to
pivot and swivel freely, and for easy removal and installation
(Figures 18-19).

Step Two - Connect the Power Cable to the Boat
A 6’ (2m) long power cable is included to supply power to the
fishfinder. You may shorten or lengthen the cable using 18 gauge
multi-stranded copper wire.
CAUTION: Some boats have 24 or 36 volt electric systems. Be
sure your unit is connected to a 12 VDC power supply.
The Power can be connected to the boat's electrical system at two
places: a fuse panel, usually located near the console, or directly to the battery.
If a fuse terminal is available, use crimp-on type electrical connectors (not included) that
match the terminal on the fuse panel. Attach the black wire to ground, and the red wire
to 12 VDC power (Figure 20). Be sure to use a one amp fuse in the connection. If you
must wire the control head directly to a battery, be sure to install an inline fuse holder
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and one amp fuse (not included) for the protection of the unit (Figure 21). Humminbird is
not responsible for over voltage or over current failures.
In order to minimize the potential for interference with other
marine electronics a separate power source (such as a
second battery) may be necessary.
Step Three - Drill the Mounting Holes
1. Set the mounting bracket in place on the mounting
surface. Mark the four mounting screw locations with a
pencil or punch.
2. Set the mounting bracket aside, and drill the four
mounting screw holes using a 9/64” (3.6mm) bit.
Step Four - Run the Cables
1. If the cables must pass through a hole underneath the
mounting surface, mark and drill a 1” (25mm) hole
centered between the four mounting holes (Figure 22).
Note: if the cables must pass through the mounting
surface at a different location, drill the 1" (25mm) hole at
that location and pass the cables through from
underneath. Also, you must break out the tabs on the
rear of the mounting base using needle nose pliers
(Figures 24-25).
2. Insert all cables through the 1” (25mm) hole from beneath
the mounting surface.
3. Pass the cables through the grommet (if the cable hole is
underneath the mounting bracket) then press the grommet
in place around the cables and into the 1” (25mm) hole.
4. Pass the cables through the mounting base, out the top of
the mounting bracket.
5. Place the mounting bracket on the mounting surface aligned with the drilled holes.
Insert the four flathead wood screws into the mounting holes and tighten fully (Figure
23).
Optional: If the cables pass outside the mounting bracket, install the hole cover
over the hole and fasten in place using the two #8 x 7/8” (22mm) wood screws
(Figure 24).
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Step Five - Assembling the Connector Holder
1. Insert the cable connectors into the connector holder.
The cable connectors are labeled, and there are
corresponding labels on the connector holder (Figure
26). The slots for the connectors are keyed to prevent
reverse installation, so do not force the connector into
the holder.
2. Carefully pull the excess cable from beneath the mounting surface so the connector holder aligns with the
mounting holes on the front of the mounting bracket
(Figure 27).
3. Snap the support plate to the rear of the connector
holder (Figure 28).
4. Insert the connector holder into place and use the two
#6-32 x ¾” (9mm) screws to fasten it to the mounting
bracket (Figure 28).
5. Install the control head by sliding it onto the mounting
bracket until it is fully seated. To remove the unit simply
depress the latch on the rear of the unit and lift (Figure
29).
Your Humminbird is now ready for operation.
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TEST THE INSTALLATION
Testing should be performed with the boat in the water, however you can initially
confirm basic operation with the boat trailered.
Press POWER once to turn the unit on. There will be an audible chirp when any button
is pressed to confirm the button press. If the unit does not power-up, ensure the unit is
fully seated on the mount and that power is available.
The first screen provides four options: Start-up, Options, Simulator, and Diagnostic. A
message at the bottom of the screen indicates the transducer connection. If no
transducer is detected (or one is not connected), the message will indicate this and the
unit will go into simulator after the initial screen times out.
Note: the transducer must be submerged in water for reliable transducer
detection.
If a transducer is detected, the unit will enter “Start Up” or normal operation unless you
choose another option. If you do not press any button before the timer reaches “0”, the
normal operation screen is displayed. If the boat is in water, sonar data appears.
If the bottom is visible on screen with a digital depth readout, the unit is working
properly. Ensure the boat is in water greater than 2’ but less than the depth
capability of the unit and the transducer is fully submerged. Remember the sonar signal
cannot pass through air.
If the unit is working properly gradually increase the boat speed to test high-speed
performance. If the unit-functions well at low speeds but begins to skip or miss the
bottom at higher speeds, the transducer requires adjustment. Refer to the appropriate
transducer installation section for more detail.
Note: it is often necessary to make several incremental transducer adjustments
before optimum high-speed performance is achieved.
Important: For Transom Mount transducer installations, install the third mounting screw
after the final transducer adjustments.
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TESTING THE INSTALLATION
After installation is complete and all connections are made, you are ready to test the installation prior to
actual use. Thorough testing should be performed with the boat in water, however, you can initially
confirm basic operation with the boat trailered.
Press POWER once to turn the unit on. There will be an audible chirp when any button is pressed that
confirms the button press. If the unit does not power-up, ensure that the unit is fully seated on the mount
and that power is available.
The first screen provides four options; Start-up, Options, Simulator, and Diagnostic. If there is no
transducer detected, only the Simulator, Options and Diagnostic will appear as menu options. The time
remaining before the screen "times-out" is shown at the bottom of the screen. If you do not press any
button before the timer reaches 0, the normal operation screen will be displayed. If the boat is on-water,
sonar data will begin to appear. If no transducer is connected or detected, the Optic will go into simulator
mode after the initial menu screen times out.
Note: The transducer must be submerged in water for reliable transducer detection.
If the bottom is visible on-screen with a digital depth readout, the unit is working properly. If the unit
powers-up but fails to display bottom information, the transducer is not properly connected. Ensure that
the boat is in water greater than 2' but less than 600' deep, and that the transducer is fully submerged.
Remember that the sonar signal cannot pass through air. Refer to the troubleshooting section of this
manual. If the unit is working properly, gradually increase the boat speed to test high-speed performance.
If the unit functions well at low speeds but begins to skip or miss the bottom at higher speeds, the
transducer installation requires adjustment. Refer to the appropriate transducer installation section for
more detail.
NOTE: It is often necessary to make several incremental transducer adjustments before optimum highspeed performance is achieved.

USING THE WIDE OPTIC
The Wide Optic is completely automatic and easy to use. Simply press the POWER button and the unit
will locate and track the bottom from 2' to 600' changing ranges as necessary, display any structure or
suspended fish and work at speeds from 0 to over 70 mph.
If POWER is the only button you use, you will benefit from the advanced automatic bottom tracking of the
Wide Optic. However, if you choose to experiment with the many features and controls the Wide Optic
offers, you can customize the presentation of information to suit your particular needs.
SIMULATOR OPERATION
The Wide Optic contains a simulator which allows you to use the unit as
if you are on the water. The Simulator is invaluable for learning how to
operate the many features of the Wide Optic. There are two ways to
enable the Simulator: if the unit is powered off, press and hold the
POWER button for approximately 3 seconds until a continuous chirp is
heard. The Simulator can also be enabled by selecting the Simulator
option on the start-up screen after you normally power-up the unit. When
this screen is shown, simply press the DOWN ARROW until "Simulator"
is highlighted. When the screen times-out, the unit will be in simulator
mode.
If the Wide Optic is powered up with no transducer connected, the unit
will automatically default to the simulator mode, as normal operation is
not possible.
Once the Simulator mode is selected, the next screen will allow you to
select either "down" simulator or "side" simulator (the "down" selection
simulates normal operation of the unit with the Tri-beam transducer
connected). "Down" simulator is the default setting, so if no adjustment is
made, the down simulator will be selected. The "side" simulator
simulates operation with a Wide Side transducer connected. This is an
excellent way to see if you like the way the unit works using the optional
Wide Side transducer.
When in simulator operation, the Wide Optic responds to control inputs
as if it is in actual operation, so feel free to experiment with the many
features and functions to customize the Wide Optic for your particular
operation. The unit will also simulate the Temp/Speed accessory by
showing water temperature and boat speed and speed readings. To exit
Simulator mode, power the unit off.

FEATURE MEMORY
If your Wide Optic is installed with a transducer connected, any changes you make to the setup or User
Options (see Control Functions) while in Simulator are retained in the unit's memory. This allows you to
use simulator to experiment with the various set-up options, and retain your selected settings for normal
operation.
If you are using the Wide Optic in Simulator when no transducer is connected, any selected options are
lost when the unit is powered off. The Wide Optic will return to Factory Settings, or options selected when
last used with a transducer, if no transducer is connected.
IMPORTANT A transducer must be connected to the Wide Optic in order to retain user settings selected
when in simulator mode. If no transducer is detected, the unit defaults to pre-selected options when
powered off.

WHAT YOU SEE ON-SCREEN
Your Wide Optic uses a 64 x 128 matrix SuperTwist LCD display. This type of display provides
outstanding viewability in all light conditions over a wide range of temperatures.
The presentation of information on-screen may take one of several forms depending on the type of
transducer being used, whether or not the Temp/Speed sensor is connected, and the current setting of
various user options. See Advanced Operation for information on custom screen options.
NOTE: When in simulator mode, the word "simulator" occasionally scrolls across the display indicating
that the information onscreen is not real sonar data.
The initial screen layout takes one of two basic forms depending on
whether the Temp/Speed accessory is installed. Figure A shows the
default view when the Temp/Speed accessory is not installed. The digital
depth number shows the depth of water directly beneath the transducer
location.
The range of the graphic display is shown to the right of the graphic
information. The upper number is 0 indicating the surface of the water,
the lower number is one of the 9 ranges available which best matches
the depth of the water. As the depth of the water changes, the range
changes as necessary in order to retain a bottom representation onscreen.
When in Auto mode, the horizontal line at the top of the graphics area is
the 0 line which represents the surface of the water. Occasionally there
will be a gap in this line. This gap indicates that the unit is updating the
display even if the bottom is not visible on-screen, or if the bottom information is not changing.
The graphic representation of the bottom may vary considerably
depending on the composition and regularity of the bottom surface (see
Interpreting the On-screen Information). Any sonar return which is
determined to be not a part of the bottom is shown between the surface
and the bottom. If this return is determined to be a fish, one of several
fish shapes is drawn which indicate size, depth, and location of the fish
(see Interpreting the Onscreen Information).
Figure B shows the default view when the Temp/Speed sensor is
connected. Water surface temperature and boat speed are displayed at
the lower right corner of the screen.
If the Wide Optic determines that a Wide Side transducer is connected,
the default view is shown in Figure C. Sonar information from both the
left and right beams are shown.
As you learn the many capabilities and user preference functions of the Wide Optic, additional screen
configurations are possible. Figure D shows a view with "Small Digits" selected in the User Options menu.
By selecting smaller digits for the depth, speed and temp information, more of the screen is available for
the graphic representation of the sonar information. This effectively increases the display resolution of the
Wide Optic, allowing targets which are very close together to be displayed as separate symbols.

INTERPRETING THE ON-SCREEN INFORMATION
Figure E shows a typical view you can expect to see on-water. New sonar information appears on the
right side of the graphic area of the display and moves to the left as new information is displayed. The
Wide Optic automatically selects the appropriate depth range to show the depth of water beneath the
transducer. This range is selected so that the bottom representation is typically shown about 2/3 down the
display.
The graphic depiction of the bottom provides the user with an effective
tool for understanding the composition of the bottom. If the bottom is
hard and smooth, the bottom depiction is narrow and dense. If the
bottom is soft mud or sand, the depiction will be thick and less dense.
This indicates that much of the signal is absorbed by the soft bottom. If
the bottom is rocky or rugged in composition, the depiction is of varying
density and textured in appearance.
Wave action also affects the bottom depiction. Remember that the
information drawn is a distance measurement, so if the boat is moving
up and down over flat bottom, the bottom depiction often appears in
regular variations which match wave timing.
Structure is defined as any object physically attached to the bottom. The
sonar configuration of the Wide Optic is optimized to give the most
accurate depiction of bottom structure possible. Grass, trees, stumps,
wrecks or other debris are accurately displayed, however the depiction of these objects varies with boat
speed and direction. The best way to learn to interpret structure is to operate the Wide Optic over a
variety of known conditions and experiment with user functions to best represent
those conditions on-screen.

Sonar targets which are not physically attached to the bottom may take one of many shapes. Surface
clutter is the layer of water near the surface which is rich in algae and other growth, and often is aerated
by wind or wave action. This area of water interferes with sonar transmission and often appears onscreen as regular clusters of individual dots near the "0" line.
Thermoclines are sharp differences in water temperature. These are easily identified by the continuous
nature of the return.
A further method of differentiation of fish symbols indicates which of the three sonar beams the fish is
detected in. This gives you a reliable indicator of side to side location relative to boat movement. Fish
symbols which are hollow are detected in the outside two beams. Hollow fish symbols facing to the right
are detected in the right beam and therefore are to the right side of the boat (as viewed from the driver
seat facing forward). Hollow fish symbols facing to the left are detected in the left beam, and thus the fish
is to the left side of the boat. Solid fish symbols represent fish which are detected in the single center
beam, and these fish are directly under the boat.

ID+ adds an additional piece of information to help the user locate fish. On selected fish symbols, the
digital depth of the designated fish is drawn to help locate the fish vertically. This is especially helpful in
setting bait depths or for downrigger operation.
When a sonar signal is reflected oft the bottom back to the transducer, there is often enough energy left in
the signal to be reflected off the surface of the water back to the bottom a second time. Second returns
appear as a slightly weaker bottom representation exactly twice the depth of the primary bottom return.
The second return is most likely to occur in shallow water and in areas of relatively hard bottom.
The Wide Optic uses advanced signal processing to further evaluate any sonar return between the
surface and the bottom. For instance, a small school of bait fish usually appears as a dense cluster of
individual dots. If the return meets certain additional criteria, a fish symbol will be assigned. There are
three different size fish symbols used to indicate the intensity of the sonar return. While signal intensity is
a good indicator of relative fish size, different species of fish have different sonar characteristics, so it is
not always possible to distinguish fish size between varying species. The signal intensity is "normalized"
for depth so that a small fish close to the boat does not appear as a large fish symbol.

CONTROL FUNCTIONS
The Wide Optic uses a simple 5-button keypad for all user input. When any button is pressed, an audible
"chirp" confirms the control input. In the event that a particular button has no function or is inappropriate
for the situation, an audible "error", or multiple chirps, will be heard.

POWER, powers the Wide Optic up for normal operation. When the unit is on,
POWER turns the unit off. POWER can also be used to go directly into Simulator
mode. With the unit powered off, press and hold POWER for several seconds until a
continuous chirp is heard.
LIGHT controls the unit's 3-position display backlight. With the unit powered on,
pressing LIGHT once will turn the backlight on "high". Pressing LIGHT a second time
will turn the backlight on "low", and pressing a third time will turn the backlight off.
The backlight is very effective for low-light and nighttime operation. When the
backlight is on, the Wide Optic will consume more power than with the backlight off.
This is important when using the Wide Optic in a portable configuration powered by a
separate battery, or when powering the unit from a trolling motor battery.
NOTE: When powering the unit from a battery such as in portable applications,
avoiding use of the backlight prolongs battery life.
The three lower buttons, MENU, UP ARROW, and DOWN ARROW work together to control the Wide
Optic menu-controlled user functions.
MENU brings a menu on-screen for adjustment. In normal operation, pressing MENU repeatedly will cycle
through all available menu headings. When the desired menu heading is displayed, the full menu appears
after a short pause. A menu remains onscreen for several seconds allowing user adjustment by means of
the ARROW keys. If no adjustment is made in the allotted time, the menu disappears. If you need the
menu to remain on-screen longer to study the adjustment options, press and hold MENU-the menu will
remain on-screen indefinitely. Once you release the menu button, the screen will time out.

Once a menu times out, it is still considered the active menu. Pressing MENU will bring up the last used
menu.
The UP ARROW and DOWN ARROW make adjustments to menu functions. On the left side of every
menu there are UP ARROW and DOWN ARROW symbols. The symbols indicate which ARROW button
has a function in a particular situation. Either one or both ARROW buttons can be used to adjust the
menu function. A hollow ARROW symbol means that the corresponding ARROW button has no function.
Pressing that button will result in no adjustment and the "error" audible will be heard. A solid ARROW
symbol means that the corresponding ARROW button can be used to affect the menu adjustment.
The ARROW buttons often can be used when no menu is on-screen. In these situations, pressing the
ARROW button affects the function of the active (last-used) menu. This is a short-cut to menu operation.
The menu appears onscreen while the adjustment is made and 'times out'. A frequently used menu can
be adjusted very quickly using this technique.
After an adjustment is made to a menu function, the menu "times out" after several seconds and the unit
returns to normal operation.

All menus use the same basic layout as shown in Figure F The heading at the top describes the menu
function (see Control Functions for more details on individual functions). The UP ARROW and DOWN
ARROW symbols to the left of the menu indicate which buttons are available for adjustment. In menus
which have numerous possible settings such as depth range, a range of adjustment indicator shows the
total range available and the current setting. Within the menu are the options available. The selected
option or current setting is highlighted in the black box. If no adjustment is made, this will be the selected
setting. Pressing one of the ARROW buttons while the menu is on-screen selects another option.
Several of the menus are multi-step. In some situations if an adjustment is made, additional options
become available for further adjustment. Examples of these multi-step menus are Depth Range, Depth
Alarm and Zoom. See the detailed description of each function for further explanation.
The one menu option which functions differently than previously described is the Options menu. User
Options is a group of functions which are used initially to select user preferences. The Options are not
normally needed during operation of the unit. Options differ from the other menu functions in that once
selected for viewing, the menu will not "time out"-all the user options must be sequenced through before
returning to normal operation. See User Options for detailed description.

MENU FUNCTIONS
Sensitivity
The Sensitivity function controls the sensitivity of the
sonar receiver. The Wide Optic automatically adjusts
the level of receiver sensitivity based on a number of
factors including the depth of the water and the level
of noise present. Noise can be caused by other
electronic devices, engines, trolling motors, propeller
cavitation and hydrodynamic flow among others.
The user has the option of biasing this Sensitivity
adjustment either higher or lower based on personal
preference. You can select one of 11 sensitivity bias
settings from -5 to +5. A bias setting of 0 (Factory
Setting) has no effect on the automatic sensitivity
control. Increasing the bias (+1 through +5) causes
the unit to display the information from progressively
smaller sonar returns. By decreasing the sensitivity bias (-1 through -5), the unit effectively filters small
sonar returns.
In murky or muddy water, it is often advantageous to reduce the sensitivity bias. This prevents the display
from being cluttered with sonar returns from debris or suspended particles. In very clear or very deep
water, it may be desirable to increase the sensitivity bias since even the smallest sonar return may be of
interest to the user.
To adjust Sensitivity, press MENU repeatedly until the Sensitivity heading is displayed. When the
Sensitivity menu appears, use the UP ARROW to increase the sensitivity bias, or the DOWN ARROW to

reduce sensitivity bias. By holding either ARROW button depressed, the unit will sequence through the
available settings until you release the button or the end of the adjustment range is reached. If additional
time is needed to study a menu, press and hold the MENU button and the menu will remain on-screen
indefinitely.
If a setting limit is reached, the ARROW symbol attached to the menu appears to be hollow which
indicates that the related button has no further function. Also, the audible "error" consisting of multiple
chirps will be heard.
After an adjustment is made, the menu disappears and the new sensitivity setting begins to affect new
sonar information as it flows on-screen. If additional adjustment is needed, the UP ARROW or DOWN
ARROW can be pressed without having to first press MENU.
The Sensitivity setting is remembered in memory after the unit is powered oft.

Depth Range
The Depth Range function controls the vertical distance displayed on
the graphic area of the display. There are 9 different depth ranges
available. The top of the range is always 0, or the surface of the water.
Ranges of 0-15', 0-30', 0-60', 0-120', 0-180', 0-240', 0-360', 0-.480', and
0-600' are available. The range which positions the bottom depiction
closest to the bottom of the graphic area of the display, will best utilize
the available display resolution.
The Wide Optic automatically adjusts the depth range depending on the
depth of the water. The unit tries to maintain the bottom depiction about
2/3 down the total range (for example, in 20' of water, the 0-30' range
would be selected). This provides the best display resolution and
therefore the best target separation possible.
The Depth Range can be adjusted manually. Press MENU repeatedly
until the Depth Range menu is visible. The two options available are
"Auto" (Factory Setting) and "Manual". Pressing the DOWN ARROW
enables "Manual" depth range control and an additional menu will
appear which allows the user to adjust the current depth range setting. If no further button is pressed, the
current depth range is selected as the desired range and the unit returns to normal operation.
Using "Manual" Depth Range control, the user can view sonar information from the area near the surface
in great detail. If a depth range other than the current range is desired, pressing the DOWN ARROW to
highlight "Adjust" will allow selection of one of the 9 available ranges. Simply press and hold the UP or
DOWN ARROW button to scan through the available options. If a setting limit is reached, the audible
"error" or multiple chirps will be heard and no further adjustment is allowed.
When "Manual" range is used, the unit no longer adjusts the Depth Range to the most appropriate range
for bottom display. Often, the bottom may not be visible onscreen. The digital depth readout always
determines the depth of the bottom, even if it is not visible on-screen.
When a Depth Range is selected manually and the Depth Range menu is still active (most recently used),
further adjustment of the depth range can be achieved by simply pressing the appropriate UP or DOWN
ARROW button. The button press will bring the Depth Range menu on-screen and allows immediate
adjustment of the range.
To return to "Automatic" Depth Range control, press the MENU button until the Depth Range menu
appears on-screen and use the UP ARROW to select AUTO. The Wide Optic returns to Automatic
operation.
Note: Depth Range is not remembered when the unit is powered off. At power up, the unit is always in
automatic depth range.

Zoom
Zoom is similar to Depth Range in that it controls the range of information displayed in the graphics area
of the display. Zoom, however, allows selection of ranges beneath the surface so any area of water
between the surface and the bottom can be enlarged to provide more detailed information. By using the
full display to show a small area of coverage, the effective display resolution is increased, and the unit's
ability to separate targets which are very close together is enhanced.
There are four different Zoom ranges available; 7 1/2', 15', 30', and 60'. These ranges are not directly
user controlled but are instead dependent on the current depth range. In shallow water, when the 15' or
30' range is in use, the Zoom range is 7 1/2'. If the 60' or 120' range is in use, the Zoom range is 15', if a
180'-480' depth range is in use, the Zoom range is 30', and if the 600' range is in use, the Zoom range is
60'.
The Wide Optic shows Zoom range in conjunction with the full depth
range. The Zoom range is shown on the left side of the screen and full
range information is shown on the right side of the display. Zoom can
either operate automatically, in which the Zoom range is constantly
adjusted to show the bottom, or manually, in which the user controls the
location of the Zoom range.
"Automatic" Zoom is especially helpful when looking for structure or
bottom detail. The "Automatic" Zoom keeps the bottom in view even in
quickly changing terrain. "Manual" Zoom provides detailed information of
any area from the surface to the bottom. In "Manual" Zoom, the Zoom
range does not move as the terrain changes.
To operate Zoom, Press MENU repeatedly until the Zoom menu is onscreen. Three options are available: "Off" (Factory Setting), "Auto"
(Automatic bottom tracking Zoom), and "Manual" (User controlled Zoom
range). Press the DOWN ARROW once to highlight Auto. When the
menu disappears, the graphics area of the screen will be divided in half.
Full range information on the right, Zoom information on the left. The
digital depth readout is unaffected by Zoom.
Pressing the DOWN ARROW again to highlight "Manual" activates Manual Zoom. The menu further
expands to show the current Zoom range, and allows user adjustment of this range.
When the range is shown in the menu, the upper number represents the top of the current Zoom range.
The lower number represents the bottom of the Zoom range. The UP and DOWN ARROW buttons can be
used to move this range. The upper number can never be less than 0 (the surface of the water), and the
lower number can never be greater than the active depth range. The difference between the two numbers
(the Zoom range) is preset and determined by the active depth range.
Once "Manual" Zoom is selected, the display will appear the same as in "Auto" Zoom, but the zoom range
does not change automatically. If further adjustment of the zoom range is necessary, pressing either
ARROW button while Zoom is active will move the Zoom range up or down. The Menu returns briefly to
show the numeric values as the adjustment is made.
To disable Zoom, press the MENU button until the Zoom menu is on-screen. Use the UP ARROW to
highlight Off, and let the menu time out.
When the unit is powered off, the Zoom menu returns to Zoom Off.

Depth Alarm
The Wide Optic contains an audible alarm to warn you of shallow water depths. The alarm is adjustable
from 2' to 99' of depth. When the alarm is enabled, an audible alarm is sounded if the water beneath the
boat is equal to or less than the selected alarm depth. Upon activation, the alarm sounds continuously for
about 5 seconds, and then intermittently to remind you that you are still in shallow water.
To enable Depth Alarm, press MENU repeatedly until the Depth Alarm menu is on-screen. The Factory
Setting is "Off". Use the DOWN ARROW to highlight On. The menu will expand to show the current Depth
Alarm setting. Use the UP or DOWN ARROW to set the desired depth for alarm activation.
Once the menu times out, the Depth Alarm is enabled. To further adjust the setting, simply press the UP
or DOWN ARROW. The menu appears briefly to indicate the setting. If the alarm is sounding and you
want to disable it, use the MENU button to bring the Depth Alarm menu on-screen, and the UP ARROW
to highlight "Off".
The most recent Depth Alarm setting is remembered after the unit has been powered off.

Fish Alarm
The Fish Alarm alerts you to the presence of fish, or other targets not
connected to the bottom. The Fish Alarm has 3 different settings which
correspond to the 3 different size fish symbols shown on-screen.
To enable Fish Alarm, press the MENU button repeatedly until the Fish
Alarm menu appears on-screen. The menu shows two options, "Off"
(Factory Setting) and "On". Use the DOWN ARROW to highlight "On" and
the menu further expands to show the 3 alarm options. The selected setting
will be "Large fish only". With this setting, the Wide Optic alarms on only
those targets which are represented by the large fish symbols (see
Interpreting the On-Screen Information). Pressing the DOWN ARROW
again highlights "large and medium fish" and pressing a third time highlights
"large, medium, and small fish). With this setting, any fish symbol appearing
on-screen activates the Fish Alarm.
Once the Fish Alarm is enabled, the Wide Optic emits an audible beep
when the selected size fish symbol appears on-screen. The sound is slightly
different for each of the three fish symbol sizes, so with practice, it is
possible to distinguish the size of the detected fish without looking at the unit.
To disable the Fish Alarm, press MENU until the Fish Alarm menu appears on-screen. Use the UP
ARROW to highlight "Off", and let the menu time out.

Fish Alarm settings are remembered when the unit is powered off.

Triplog
Triplog provides a running log of information based on input from the Temp/Speed sensor. Since Triplog
requires information from the Temp/Speed sensor to operate, if this sensor is not detected by the Wide
Optic, the Triplog menu will not appear as an option.
To enable Triplog, press MENU repeatedly until the Triplog menu is onscreen. The Factory Setting is "Hide" which is selected. Use the DOWN
ARROW to select "Show" and the fullscreen Triplog will appear.
Triplog provides seven pieces of information; the current digital depth,
water surface temperature, current boat speed, the distance traveled
since the Wide Optic was powered up or reset, the average speed, the
total time elapsed since power-up or reset, and the input voltage from
your boat's electrical system.
The time, speed, and distance calculations are useful for tracking your
progress on a trip. The input voltage is useful for determining the
condition of the charging system of the boat. When used in a portable
application or whenever the Wide Optic is operated from a battery
source, the voltage number can be used to determine battery life. The
Wide Optic will operate at voltages from 10 to 16 VDC. Voltages in
excess of 16 or less than 10 VDC will cause the unit to power off.
Once Triplog is enabled, pressing MENU to bring the Triplog menu on-screen now shows an additional
option, "Reset". By selecting Reset, the timer and distance log resets to 0 and the Triplog will begin to
calculate elapsed time, distance traveled, and average speed from the time of reset.
To disable Triplog, press the MENU button until the Triplog menu is on-screen. Use the UP ARROW to
select Hide and let the menu time out. The Triplog continues to operate and log time and distance even
when it is not visible onscreen. The Triplog resets at power off.

Options
The Options Menu is actually a series of linked menu functions which are used initially to select user
preferences. Once user preferences are selected, it is unlikely that these functions need to be accessed
during the normal operation of the product.
The Options menu works differently than other menu functions in that all of the options must be cycled
through in order to return to normal operation. There are six Option menus: Units, Fish ID, Numeral size,
Transducer, Display speed, and Reset.
Press MENU until the Options menu is on-screen. There are two choices, Hide (Factory Setting) and
Show. Use the DOWN ARROW to highlight Show and the first Options menu appears.

Units

The Units function allows the user to select the units of measurement
for the speed readout. Both MPH or statute miles per hour and KTS
or nautical miles per hour are available. Use the ARROW buttons to
highlight the desired selection. The Wide Optic remembers this
selection even when the unit is powered off. Press MENU to go to the
next menu.

Fish ID
The next Option menu is Fish ID. There are three selections available; Off,
ID On, and ID+ On. The factory setting is ID+ On. With Fish ID Off, sonar
returns are displayed as "raw" information. There is no interpretation made
by the unit. Selecting ID Off, also will disable the fish alarm.
ID On enables the Wide Optic to interpret the raw sonar data and, using a
variety of techniques, depict appropriate target returns as one of three
different size fish symbols. Further identification shows whether the fish is
in the left, center, or right beam.
ID+ On adds an additional piece of information to the location of the fish. The depth beneath the surface
for selected fish symbols is attached to the fish symbol.

Use the ARROW buttons to highlight the desired setting, and press MENU to advance to the next menu.
The unit remembers Fish ID setting when powered off.

Numeral Size
Numeral Size is the next Option menu. Two options are available: Big
and Small. The factory setting is Big. With this setting, the digital depth
and speed and temp numerals are drawn large enough to be readable
from across the boat. The big numerals occupy space on the display
which could be used for the graphics area. Hence, the small numerals
option. With small numerals selected, a greater amount of the display
area is available for the graphic view. This effectively increases the
display resolution of the unit. Sonar targets which are very close together
can often be displayed as separate targets, though the distance from
which the numerals are readable is somewhat less.
Use the UP and DOWN ARROW buttons to highlight the desired
selection, then press MENU to advance to the next menu.
Numeral Size settings are remembered when powered off.

Transducer
The Transducer option allows manual selection or identification of a
non-standard transducer. The Wide Optic is designed to work with the
TriBeam transducer supplied with the unit. There are several instances
in which an alternative transducer may be used (i.e. a Wide Side or a
trolling motor mount transducer). Often two transducers are used in
conjunction with a transducer switch to provide increased utility.
The Wide Optic has the ability to positively identify a Tri-beam
transducer. If this identification is made, the unit operates normally with
no further input from the user. If a transducer other than the Tri-beam
transducer is connected, the Wide Optic will assume this transducer is
a Wide Side transducer (available as an accessory) and the screen
layout will change automatically to show the Wide Side display.
In the event that a non-standard transducer other than the Wide Side is
connected (Dual Beam), the user must manually identify this transducer so that the Wide Optic can
interpret the information received. Once this identification is made, the unit defaults to this setting
whenever a nonstandard transducer is detected.
The Transducer Option menu provides three options; Tri-beam, dual, and side. If a Tri-beam transducer is
connected to the unit, the Tribeam selection is highlighted. It is not possible to select one of the other
options.
If a non-standard transducer is detected, an option other than Tri-beam is highlighted. If no previous user
selection has been made, Side will be the default. If the Wide Side transducer is connected, then the
proper selection has been made and no further user input is required. If a dual beam transducer is
connected, use the ARROW buttons to highlight that selection. With dual selected, anytime the Wide
Optic detects a transducer other than the standard Tri-beam, the unit will assume that transducer is a
dual beam.
Note: If a non-standard transducer is detected, it will not be possible to select the Tri-beam option in the
Transducer Options menu. If a Tri-beam transducer is detected, only the Tri-beam selection is possible.
Often it is desirable to use a transducer switch to connect two Tri-beam transducers or a Tri-beam
transducer and a non-standard transducer to the Wide Optic. In either of these situations, the Wide Optic
identifies the Tri-beam transducer and operates normally when that transducer is selected by the switch.
If a non-standard transducer is selected by the switch, the Wide Optic will assume that transducer is of
the type identified in the Transducer Options menu, and will configure the display accordingly.

Note: If two non-standard transducers are connected to the Wide Optic through a transducer switch, the
Transducer Options menu must be used to manually identify which transducer is in use, as the Wide
Optic has no way to identify non-standard transducers.
Once the transducer selection is made, use the MENU button to advance to the next Option.
The transducer setting is remembered when the unit is powered off.

Display Speed

Display Speed controls the rate which the graphic information moves
across the display. There are 5 possible speeds, the fastest rate (5) is
the factory setting. If your boat is stationary or moving very slowly for
extended periods, it may be desirable to update the display at a slower
rate. The closer the update rate matches boat speed, the more
accurate is the graphic depiction of the terrain beneath your boat.
Use the UP and DOWN ARROWS to select the desired update rate.
(1) is the slowest, (5) is the fastest.
Use the MENU button to advance to the next menu.
Display setting is remembered when the unit is powered off.

Reset
The final Option is Reset. With so many User Options available to customize the Wide Optic, it is easy to
configure the unit in such a way that it is detrimental to a particular use. By using the Reset function, all
variable or user-controlled features of the Wide Optic are returned to the factory settings.
The Reset function is an important first step in trouble-shooting problems to ensure that a user selected
setting is not the cause for the perceived problem.

Use the ARROW buttons to highlight "Yes" and the unit will return to factory settings. After making the
selection, press MENU to end Options and return to normal operation.

CUSTOMIZING SET-UP FUNCTIONS

The Wide Optic allows the user to customize many features to work best for a particular type of use.
These user selections are remembered by the unit after power is disconnected. Control of these features
is accomplished through the menu system. Primary menu functions include Sensitivity, Depth Range,
Zoom, Depth Alarm, Fish Alarm, Triplog (if the Temp/Speed sensor is connected) and Options.
The Options menu is a grouping of user preferences which are normally set initially but not typically
needed in the normal operation of the product. Options are accessed in one of two ways. At powerup,
direct access to the Options menus is given on the start-up screen. This is a quick way to adjust user
options before beginning normal operation. Also, as mentioned, the Options menus are part of the normal
menu system and is accessible any time.
Options allows the user to select the units of measurement for speed, the method of depicting fish
targets, the basic screen layout and size of numeric information, selection of non-standard transducers,
adjust the speed of update of the display, and reset of all variables to Factory Settings.
IMPORTANT A transducer must be connected to the Wide Optic in order to retain user settings selected
when in simulator mode. If no transducer is detected, the unit will default to factory options when powered
off.
Refer to Menu Functions for detailed information of User Options.

USING DIAGNOSTIC
The Wide Optic contains a powerful diagnostic tool which can aid in
determining the cause of a problem. To enable Diagnostic, power the
unit on and use the DOWN ARROW button to highlight the Diagnostic
option on the initial screen. Diagnostic can only be accessed at powerup.
After the menu times out, the first of two diagnostic screens will appear.
Upon enabling diagnostic, the Wide Optic will perform a selftest. This
test confirms the operation of all internal circuitry. At the conclusion of
the test, one of two messages will appear; "passed" indicates that the
internal test discovered no failures. "Failed" indicates that a significant
internal problem was discovered and the unit will require factory service.
In conjunction with the failed indication will be a code which indicates to
the repair personnel where the problem is.
Even if the self-test is passed, other messages may be present to indicate an abnormal situation.
Examples of these are high-voltage and lowvoltage shut down indications. The Wide Optic will shut down
to protect the inner circuitry if the input voltage exceeds 16 VDC or is less than 10 VDC. If either of these
conditions cause the unit to shut down, a message will indicate this.
NOTE: Powering the unit off will reset these messages.
Press MENU to advance to the second Diagnostic screen.

The second Diagnostic screen evaluates external connections to the
unit. The first category is Transducer input. If a transducer is detected, a
message will indicate "connected". This is an excellent way to confirm
transducer connection. If a transducer is connected directly to the unit,
the connection will be indicated here. If a switch is used, use Diagnostic
to confirm the connections from each transducer. If a series of dashed
lines is shown, then no transducer is connected or there is a problem
with the transducer or cable.
The next categories indicate the connection of boat speed sensor and
surface water temperature sensor. These accessory sensors can be
purchased independently or together as a single sensor (see Available
Accessories). If the sensors are connected and working properly, a
"connected" message will appear.
Note: This feature only works when the boat is in motion as the paddle wheel on the speed sensor must
rotate to be detected.
The voltage input category is especially helpful in diagnosing input voltage problems. The current input
voltage will be displayed. If voltage fluctuations or power supply in excess of 16 VDC or less than 10 VDC
is suspected, use the diagnostic screen to confirm input voltage. Often, small outboard motors do not
effectively regulate voltage when operated at high engine speeds. Use Diagnostic while running the boat
at high speeds to show the voltage gain. Also, if you are using the Wide Optic in portable configuration or
from the trolling motor battery, Diagnostic can be used to evaluate the health of the battery by showing
the current voltage.
The total time category indicates the total time the unit has been in use since shipped from the factory.
Note: It is normal for some hours to be indicated in the total time when the unit is new due to factory
testing.
While this is often of interest to the user, it is primarily a diagnostic tool for the repair technician should
service be required.
Press MENU again to exit Diagnostic.

USING ALTERNATIVE TRANSDUCERS
The Wide Optic is designed to operate with the Tri-Beam transducer included standard with the product.
The standard transducer can be mounted on the transom of the boat, or bonded to the inside of most
fiberglass hulls. Tri-beam transducers are also available in trolling motor mounts, portable mounts, and
bronze thru-hull type mounts.
The Wide Optic also has the ability to work with the Wide Side Accessory Transducer. See Available
Accessories for selection of the transducer.

Wide Side Operation
The Wide Side transducer is a specialized "side-looking" transducer
which is extremely useful for bank fishing or looking for bait fish in open
water. The Wide Side transducer uses 3 different sonar elements which
transmit signals to the left, right, and straight down from your boat. The
downward beam is 200 kHz with a 24 degree area of coverage. This
beam maintains a continuous digital depth readout from the bottom
directly beneath your boat. The side beams are 455 kHz with a 16
degree area of coverage. The sidelooking elements can be used
independently, or together to locate targets near the surface of the water
on either side of your boat.
The Wide Side transducer is available as a trolling motor mount, a
transom mount, or a portable mount.
Note: The Wide Side transducer can be connected directly to the Wide
Optic or used in conjunction with the standard transducer through a
transducer switch. When used with a switch in conjunction with the TriBeam transducer, the Wide Optic
recognizes which transducer is connected whenever the switch position is changed.
When a Wide Side transducer is connected, the screen display changes to display the information from
the side-looking elements. There are four basic views available when the Wide Side transducer is in use:
both, left, right, and down. These views are controlled by the View Menu, which is only present when
operating in Wide Side mode. The default view is both, in which information from both the left and right
elements are displayed on-screen. The digital depth of the water beneath your boat is always present.
Viewing both left and right sides simultaneously gives you an excellent tool when searching for bait fish in
open water, or when following a creek bed, however greater display resolution can be achieved by
viewing only one side.
To change the view, use the MENU button to bring the View menu
onscreen. Use the ARROW buttons to select one of the four possible
views. The Down view is similar to the traditional view when using the
standard transducer, however there is no Tribeam information available
such as fish location.
When operating in Wide Side mode, the range must be adjusted
manually, since the bottom is often not visible on-screen. Ranges of 15,
30, 60 and 120 feet are available. Also, Zoom is not possible in Wide
Side mode, and the Zoom menu is not available.
Experiment with the Wide Side transducer while operating it in a familiar
area to learn how to maximize use of the information displayed.
Remember that if you are using a trolling motor mount, the information
displayed is controlled by the direction the trolling motor is pointing, not
necessarily the direction the boat is traveling.
To return to normal "down" operation using the Tri-beam transducer, simply change the switch setting if
you are using in conjunction with a transducer switch, or reconnect the Tri-beam transducer. The Wide
Optic will reconfigure the screen automatically.

